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Recently Edited List 

When you're working with Photoshop Elements you can go under the File menu and 

choose Open Recently Edited File (image) and by default you will see a list of the last 

10 files you had open. However if you would like to have more images available it is 

simple to change that.  

In any edition of Elements go to Edit>Preferences>Saving Files and change “Recent file 

list contains” to any number up to 30.  

 

It pays to check out the preferences for many everyday settings you might find 

something that you like better than the default.  
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Choose Your Home Page 

What’s the first thing you see when your browser starts up? If you’re using Internet 

Explorer, it’s probably MSN’s website. Chrome loads up a modified Google page and 

Firefox has its own start page. But if you then type in an address or hit a bookmark 

button to go to the same website first thing, then why not have your browser start there? 

In Chrome, click the icon on the right with the three horizontal bars and choose Settings. 

On the left column, choose Settings and then look under On Startup. Set it to “Open a 

specific page or set of pages” and then click the “Set pages” link.  Types in one or more 

Web addresses and click OK. Those will load up when Chrome starts. 

In Firefox, click the orange Firefox button and select Options>>Options. On the General 

tab, set “When Firefox starts” to “Show my homepage.” Then under that, type in the 

address you want for your home page. Then click OK.If you want to load multiple pages, 

load them up in tabs and then click the “Use Current Pages” button. Or you can click 

“Use Bookmark…” and select a folder of bookmarks. 

In Internet Explorer, click the gear icon on the right and select Internet Options. Go to 

the General tab and under “Home page” enter the Web address or addresses you want 

to see on startup. 

In Safari on Apple, go to Safari>>Preferences. On the General tab, go do to 

“Homepage” and type in an address. Use Bookmark…” and select a folder of 

bookmarks. 

Selecting a Circle 

If you have to select a circle you might already know to constrain the Elliptical Marquee 

tool to a circle you hold down the shift key while 

making a selection. The hard part is getting the 

selection to be exactly the right size. Not only that, but 

then you also have to get it positioned right on the 

circle. The trick to overcoming these obstacles is to 

hold down the shift key with one finger and hover your 

thumb over the spacebar. Begin making your 

selection, and then without letting go of the shift key or 

the mouse button, press the spacebar down with your 

thumb. 



3 | P a g e  
 

This action will stop growing your selection and instead when you move the mouse it 

will move your selection. You can then take your thumb off the spacebar to continue 

drawing your selection. This is way faster than guessing at your circle size and then 

dragging it into place. 

The way I do it is I hold down the shift key with my middle finger and hover my thumb of 

the same hand over the spacebar. I use my opposite hand to operate the mouse. It's the 

fastest way I know to select a circle in Photoshop Elements. 

Addictive 

I have often wondered about the strange sound techniques used on many recordings, 

just how they get those strange echoes and repeating sounds. Well I found a website 

that mimics many of them and you can play with them yourself. A warning though, it can 

become addictive! To sample this go to: http://www.femurdesign.com/theremin/ 

Somewhere 

I think we can all appreciate a photograph of beautiful scenery. I just stumbled across 

this website where they show some spectacular images. It is the brainchild of a 

designer in Paris, Benjamin Netter. Whilst doing research for a travel project he started 

a blog called “somewhere” on Instagram with pictures from all over the world and a  

description of the place. You can either browse through randomly selected photos or 

search for a particular place. It is intriguing and very informative. Check it out here. 

MFT Picture Box 

It's nice to have a digital film history, but sometimes you run across photos and don't 

remember where and when they were taken. If only there was some easy way to figure 

it out. 

As a matter of fact, there is thanks to MFT Picture Box for Windows. This program came 

about courtesy of a UK serviceman in the Digital Forensics Unit. He needed a fast way 

to catalog images using the Exchangeable Image File (EXIF) information. 

It's true you can just look at the image properties in Windows to get this information, but 

that's not practical for more than one or two images. 

MFT Picture Box can tell you what camera the photos were taken with, when the 

pictures were taken - date and time - and display the images and data side by side for 

quick comparison. You can even export the data into an Excel spreadsheet to better 

catalog your vacation photos. 

http://www.femurdesign.com/theremin/
http://smwh.re/haiku-stairs
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The program can also give you the GPS location of photos for GPS-enabled phones 

and cameras. You can export the GPS information as a KML file to Google Earth, so 

you can see where you took the photo, or get a history of a trip. 

To use Picture Box, open the program and go to File>>Open. From here you can select 

a folder or directory of images to get the information from them. Once you have the 

information, you can export information to Excel or as a KML file to Google Earth. 

For further information and a download check here. 

KVAD Photo +  

With this app for Windows 8 users can turn their devices into a fantastic photo editing 

studio that allows them to mix operations, clips, and effects. It features base photo 

operations: brightness, contrast, RGB color adjustment, hue, saturation, and blur, 

transform operations: resize, rotate, and crop, 47 filters and effects, apply digital frames 

to your photos. Install additional packs 'Holidays Frames' and 'Christmas Frames', 

action sets: you can save your actions and apply it to other photos, save and share the 

result photo as Small, Normal, Large or Original, supported output formats: JPG, PNG, 

BMP, and TIFF, and quality and DPI settings. This only works with Windows 8 or above, 

another reason for upgrading! You can also find the pro version in the Windows store 

for $3.99 but I would try the free version first. 

The KVAD group has also developed an application for your Android smart phone and 

BlackBerry (does anyone still have one of these?) called Photo Studio. This is utilized 

by both amateur and professional photographers who seek simple, but powerful image 

processing on-the-go. 

Foe details of these and other KVAD products go to http://www.kvadgroup.com/. 

Print Friendly 

Have you tried printing a web page by using copy and paste into Word or something 

similar? It’s not an easy task especially when there are lots of images, ads and other 

stuff you don’t want to copy.  

There is an easier way, try using “Print Friendly”. This free program can be loaded and 

set as a button on your bookmark bar in Chrome (or Internet Explorer, Firefox, Safari 

etc.) so it is always available when you are surfing the web. I have installed it and find it 

great for not only copying web pages but also editing them by removing images and 

also you can send your document as a PDF to anyone by e-mail.  

For details go to: http://www.printfriendly.com/ 

http://mft-picturebox.software.informer.com/
http://www.kvadgroup.com/
http://www.printfriendly.com/
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Batch Processing 

I had a query about how to resize several images simultaneously instead of individually. 

Using 

Elements the 

method is to 

create two 

folders on 

your desktop 

or wherever 

is convenient 

and name 

them before 

and after. Put 

all the 

pictures you 

want to resize 

in the before 

folder and 

then go to 

File>Process 

multiple files 

(see picture 

on right). A 

dialog box will 

appear. In the 

top/left click 

on Browse… 

next to the 

Source field 

and navigate to the before folder. Click browse next to the destination box and select 

the “after” folder. Click on the Resize Images box and enter your Width and Height into 

the appropriate fields (you may have to uncheck Constrain Proportions to be able to 

enter the size you want. Choose a dpi from the Resolution field and Click OK to process 

your photos.  

It is also useful for renaming or renumbering a photo shoot. You are all aware of your 

cameras liking for numbering shots “DSCN2071” or something similar, you can use this 

feature to rename a series of pictures taken at say a wedding, wedding1, wedding2 etc.  
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Note also this multiple file processing can also be used to apply levels, contrast color 

and sharpen to images but this can be a hit or miss procedure when the originals have 

widely varying properties. These batch processing are best applied to multiple images 

taken at the same time or of the same or similar subjects. Note you can also add your 

own watermark to images, useful if you want to protect your masterpieces from being 

plagiarized!  

For those with really old versions of Elements there is a “batch file processing tutorial” 

on my website on the SIG tutorials page which covers version through Elements 4.  

Phony Phone Numbers 

Are you wary of writing your phone number on forms on the web, you know the ones 

“required” by retailers or from sites that “require” it before giving out information?  The 

easiest way around this is to use your area code (925 for most of us) plus 555-1234 or 

any other combination for the last four digits. The prefix “555” is a non-existent code for 

all area codes and in fact is used frequently in movies, TV shows etc. Using this allows 

you to enter a number that will not only appease the recipient but won’t annoy anyone 

else!  

By the same token if you want a temporary e-mail try http://10minutemail.net/en/this will 

give you a temporary e-mail address for ten minutes but can be extended (see site) 

great for getting a quick download and then avoiding spam! 

eFixPro 

eFix Pro is a system optimizer program that is typically added when you install another 

free software (video recording/streaming, download-managers or PDF creators) that 

had bundled into their installation this program. Very often users have no idea where did 

it come from, so it’s not surprising at all that most of them assume that eFix Pro is a 

virus. This program is also bundled within the custom installer on many reputable 

download sites, so if you have downloaded software from these websites, chances are 

that eFix Pro was installed during the software setup process. 

You may also receive an e-mail touting the capabilities of a free utility called eFix, PC 

World is sending one out right now which when installed cajoles you into buying the 

paid version after “finding” numerous registry problems. 

eFix Pro it’s technically not a virus, but it does exhibit plenty of malicious traits, such as 

rootkit capabilities to hook deep into the operating system, browser hijacking, and in 

general just interfering with the user experience. The industry generally refers to it as a 

“PUP,” or potentially unwanted program. 

http://10minutemail.net/en/
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I know of several computer club members who have had the misfortune to get infected 

with this and after some investigation I think this tool will take care of uninstalling and rid 

your machine of the pest. 

Well that is all for this edition of the newsletter I hope you enjoy it don’t forget any 

contributions are very welcome!  

FINAL THOUGHT: 

Of all the possible utensils that could have been invented to eat rice with… how did two 

sticks win out? 

http://malwaretips.com/blogs/efix-pro-virus-removal/

